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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in January 2024

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Index Name Index Name
HS Mainland
0.4%
Banks Index FTSE A50 Index 3.9%

MSCI China A 50 Index -6.76% -

CSI 300 Index -6.3%

CES120 Index -6.3%
HSCEI -10.0%

% Change % Change
Equity Index Futures Access Codes
Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv 0#HMBI: 0#HCHH: 0#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg

As at 31 January 2024
Information for reference only
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Equity Index Futures & Options

Hang Seng Index (HSI) Futures & Options

HSI Products

(2024 vs 2023)

HSI Futures 158,800 (+15%)

Mini-HSI Futures 96,408 (+6%)

HSI Options 26,501 (+16%)

Mini-HSI Options 18,507 (+49%)

HSI Futures

. 4, +24%
Options 339 ( 6)

HSI Volatility 00)
Index Futures

HSI Dividend
Point Index
Futures

9 (-80%)

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 January 2024

X

156,477 (+11%)

21,788 (+30%)

91,858 (+18%)

31,058 (+53%)

69,677 (+55%)

0()

528 (+25%)

HSI Futures (YoY)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

280,000 - mmmmm ADV (L-Axis) - 200,000
240,000 - Open Interest (R-Axis)
200,000 - ,\/ - 150,000
160,000 - \/ N
- 100,000

120,000 -

80,000 ~ - 50,000
40,000 -

0 - 0

HSI Futures (MoM)

Open Interest
(No. of Contracts)

Av erage Daily Volume

(No. of Contracts) .
200,000 - = ADV (L-Axis)

Open Interest (R-AXxis) '
150,000 - I d+ 150,000
Tl
100,000 - - 100,000
50,000 - - 50,000
0 1 -0

HSI Options (YoY)

Open Interest
(No. of Contracts)

Av erage Daily Volume
(No. of Contracts)

,000 - ADV (L-Axis) - 400,000
Openlnterest (R-Axis)
45,000 - - 300,000
30,000 - - 200,000
15,000 - - 100,000
0 L e e s ey e e e S 0
NGRS I I LN
S S B S S

HSI Options (MoM)

Open Interest
(No. of Contracts)

Av erage Daily Volume
(No. of Contracts)

30,000 - ADV (L-Axis) - 200,000
Open Interest (R-Axis)
- 150,000
15,000 - \’\/\_/\/ - 100,000
- 50,000
0 - 0
Se2Es22029 <
$22833336248
2023 2]024




Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level

HSI & Top 5 Constituents

L Includes the largest and most ('000)
Index Description o ) ) 30
liquid stocks listed in Hong Kong 19 - HSI VHSI - 28 130 4 HSI Index Tencent

Index Level 15,485.07 (As at 31 Jan 2024) HSBC —AIA
18 26 120 { ——CCB Baba

Index Volatility (30-Day Historical) | 27.0
17 - 110 -

Index Avg. Day High-Low Range 226.58 (Jan 2024) L o4

. 16 100 -

HSCE! Correlation (2024) 0.993
15 r 22 90

Hang Seng Index Futures 14 ; ; 20 80
Nov-23  Dec-23  Jan-24 Nov-23 Dec-23 Jan-24

HK$50

Contract Multiplier

Notional Value (1 Contract) HK$0.77Mn (As at 31 Jan 2024) Distribution of HSI Index

Options Ol in Month-end

Call Put
Transaction t* 38.0
g 8
Stamp Duty NA S a0
— 31.0 @
Trading Fee HK$10 / contract 3 x
T a0 2240
SFC Levy HK$0.54 / contract = 7 Z
n % =
Commission Rate Negotiable 3 17.0 3 17.0
© =
£
Margin as of 30 Jan 2024 HK$54,950 100 | . . . . . 100 = . . .
0 1 2 3 4 5 6 0 1 2 3 4

Open Interest (‘000)

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 January 2024

X

Open Interest ('000)



Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY HSCEI Options (YoY
HSCEI Products p ( )
ADV or* _
(2024 M 2023) Average Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)

240,000 | ADV (L-Axis) - 700,000 120,000 - ADV (L-Axis) - 2,800,000
Open Interest (R-Axis) Open Interest (R-AXis)
l - 600,000 ] - 2,400,000
HSCEI Futures 215,085 (+15%) 549,993 (+1%) 200000 [ e00.000 100,000 [ 200,000
160,000 - : 80,000 - s
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini HSCEI 80,000 - 40,000 -
SC 9,867 (+2%) 6,227 (+33%) - 200,000 - 800,000
FUITES 40,000 - - 100,000 20,000 - - 400,000
0 - 0 (EIMEEEETNEESNE Y,
UG I
N X>* X0 N P qb %
Q" Q" Q" Q" QY O Q" Q" Q" Q" QY O Qq/
HSCEI Options 35,980 (-10%) 931,288 (+16%) vYY v e v vve v v ve
HSCEI Futures (MoM) HSCEI Options (MoM)

.. Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
Mini HSCE 4,958 (+45%) 28,436 (+263%) (Moo Coms) (No-of Contracs) (oo Corree (o ef Comacts)
Options 275,000 | s ADV (L-AxiS) - 800,000 80,000 - ADV (L-Axis) - 2,000,000

Open Interest (R-Axis) Open Interest (R-AXis)
HSCEI Fut 220,000 1 - 600,000 60,000 - - 1,500,000
utures

e 44,180 (+29%) 936,695 (+37%) 165,000 -

ptions - 400,000 40,000 - - 1,000,000

110,000 -
HSCEI Dividend 55,000 - - 200,000 20,000 - - 500,000
Point Index 318 (-60%) 21,986 (+26%)
Futures 01 . 0 0 0
SoxESD203 IS . — i
122833356248 222857355345
2023 024 2023 oda

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 January 2024
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Equity Index Futures & Options

HSCEI Futures & Options

HSCEI

Comprises the largest and

Index Description o
most liquid H shares

Index Level 5,194.04 (As at 31 Jan 2024)

Index Volatility (30-Day Historical) | 30.4

Index Avg. Day High-Low Range 105.45 (Jan 2024)

Correlation with HSI, CES120 (2024)| 0.993,0.967

Correlation with CSI300, FTSE A50

0.795,0.712
(2024)

Contract Multiplier

HK$50

Notional Value (1 Contract) HK$0.26Mn (As at 31 Jan 2024)

Transaction Cost*

Stamp Duty N/A

Trading Fee HK$3.5 / contract
SFC Levy HK$0.54 / contract
Commission Rate Negotiable

Margin as of 30 Jan 2024 HK$21,950

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 January 2024

X

HSI vs HSCEI

102
100

e H S| e HSCEI

e

86 T T r r
2-Jan 9-Jan 16-Jan 23-Jan 30-Jan

Call

14.0
12.0
10.0
8.0
6.0
4.0
2.0

Index Strike Price ('000)

10 20 30 40
Open Interest ('000)

o

HSCEI & Top 5 Constituents

150 -

e HSCEI China Mobile
Tencent — CCB
130 - Meituan Baba
110 A
90 -
70 -
50
Nov-23 Dec-23 Jan-24

Distribution of HSCEI Index Options Ol in Month-end

Put
gl4.0
o
12,0

(]
glo.o
L0

=
=

()
x 6.0
[0}
°
£40

2.0

0 20 40 60
Open Interest ('000)




Weekly HSI & HSCEI Options Performance
Weekly HSI Options

o Vol
Contract Multiplier HK$50 (,\‘,’o‘_‘g‘f@mraﬂs)
Liquidity Providers Eclipse, I-Access, IMC, Maven, Optiver 40.000 - ® Weekly HSI Options
35,000 - m Weekly HSCEI Options
Transaction Cost* 30,000 1
25,000 -
Stamp Duty N/A 20,000 -
Trading Fee HK$10 / contract 15,000 -
10,000 -
SFC Levy HK$0.54 / contract 5,000 -
Commission Rate Negotiable O'HHHHHHHHHHHHHHHHHHHHHH
NP IFTHNIFTOITANORN BTN DNITITDO DO o
A NN NANNNOMOM
i Volume
Weekly HSCEI Options e contracts) |
Contract Multiplier HK$50 20,000 - =\\eekly HSI & HSCEI Options Call
L . . . e\ eekly HSI & HSCEI Opti Put
Liquidity Providers Eclipse, I-Access, IMC, Maven, Optiver 16.000 - eexty ptions U
. 12,000 -
Transaction Cost*
8,000 -
Stamp Duty N/A
. 4,000 -
Trading Fee HK$3.5 / contract
0 T T T T T T T T T T T T T T T T T T T T T
SFC Levy HK$0.54 / contract dddddddddddddddddddddd
NP IFTOH DI ANDNDONVONDITWO DO A
Commission Rate Negotiable T A A A A A AN o®

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 January 2024
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2024 vs 2023) _— No. of Single Stock Derivatives

Stock Futures 7,998 (+23%) 25,883 (+6%) Single Stock Futures
Stock Options 649,510 (+7%) 10,130,487 (+14%) Single Stock Options 126
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts) (No. of Contracts) (No. of Contracts)

12,000 - mm ADV (L-Axis) - 40,000 800,000 - ADV (L-Axis) - 12,000,000 Stock Futures
10,000 - Open Interest (R-Axis) Open Interest (R-Axis) _ | 10,000,000

- 30,000 600,000 -

8,000 - - 8000000 * Products
6.000 - . 20000 400,000 - - 6,000,000 > 3 A-shares ETFs futures contracts
4.000 - 4,000,000 > Total 98 stock futures contracts
' L 10,000 200,000 -
2,000 - ' ~ 2,000,000
0 0 T T T T T T T T T T T T 0
N o 2 D gV
N
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts) (No. of Contracts) ( ) (No. of Contracts) » 3 A-shares ETFs options contracts
. ADV (L-Axis) . 800,000 - ADV (L-Axis - 12,000,000 i
10,000 Open Interoat (R-Axis) | 40:000 W > Total 126 stock options contracts
8,000 - I l
30,000 600,000 - 8,000000 * Market Makers (MMs)
6,000 1 90000 400,000 - > 3 types of market makers (PMM/ CQMM/
4,000 4 | - 4,000,000 QRMM)
2000 | L 10,000 200,000 - »> CQMM to provide 50 series continuous
’ quotations
01 r 0 0 > > O 0
o o - oan
$22833355248
2023 21024

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 January 2024
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Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 31 January 2024)

Tracks the largest technology companies
Index Description
listed in Hong Kong Open Interest
(No. of Contracts)
500,000 -
Hang Seng TECH Index Futures & Options & Futures Options 400.000
Contract Multiplier HK$50 per index point '
Notional Value (1 Contract) HK$150K (As at 31 January 2024) 300,000 -
No. of Liquidity Providers N/A 200,000 -
100,000 -
Transaction Cost* 0
Stamp Duty N/A 2 8 &8 ® § 3 2 & 5 3 8%
L S < = @] )
Trading Fee HK$5.00 / contract = < 0 z 0 Iz 4|
SFC Levy HK$0.54 / contract 2023 02
Average Daily Volume (as of January 2024)
ADV
(No. of Contracts)
150,000 -

100,000 -

50,000 -

0 -

2023 kon

Providing investors with a tool to manage their risk exposure

: ) Volume and Open Interest continue to growth
to Hong Kong-listed technology companies

Data Source: HKEX

* Exclude commission fees

Information for reference onlv

As at 31 January 2024
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MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of January 2024)

L Balanced representation from 11 sectors
Index Description

of top 50 China A shares ADV
Index Level 1,694.03 (As at 31 January 2024) (No. of Contracts)
25,000 -
Index Volatility (30-Day Historical) | 18.9 20.000
Index Avg. Day High-Low Range 21.36 (January 2024) 15,000
CSI300 Correlation (2024) 0.954 10,000
FTSEA50 Correlation (2024) 0.97 5,000
0
S S
. =] )
MSCI China A 50 Connect Index Futures -
Contract Multiplier US$25 2023 12024|
Notional Value (1 Contract) US$0.04Mn (As at 31 January 2024) Open Interest (as of 31 January 2024)
Average Quote Size US$0.21Mn (5 Contracts)
Open Interest
(No. of Contracts)
25,000 -
Transaction Cost*
Stamp Duty N/A 20,000 -
Trading Fee US$0.5 / contract -
15,000 -
SFC Levy US$0.07 / contract
Margin as of 30 Jan 2024 US$2,400 10,000 L — _
8 5 53532835 3 8|5
r = < = » 72 & n O z a|~
2023 hOZJ
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 31 January 2024



MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$46K (As at 31 January 2024)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 January 2024

Open Interest (As of 31 January 2024)

Open Interest
(No. of Contracts)

110,000 -
100,000 -
90,000
80,000
70,000
60,000

a =
3 =

Feb
Nov

= > c
2 © S
< s »

Aug

2 g
$ O

2023 h024

Average Daily Volume (As of January 2024)

ADV
(No. of Contracts)

40,000 -
30,000
20,000

10,000

0

[a T ]
2023 kon

Volume and Open Interest continue to growth
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

L representation 2 DM countries (excl. Japan)
Index Description L . Open Interest
and 9 EM countries in Asia (No. of Contracts)

Index Level 488.45 (As at 31 January 2024) 1,200

1,000 -
Index Volatility (30-Day Historical) | 15.4 800 -
Index Avg. Day High-Low Range 4.59 (January 2024) 600 -

400 -
HSI Correlation (2024) 0.885 200 -
HSCE Correlation (2024) 0.855 0 2 = = - = = o a = = o=
c S S 3]
g = < £ 3> 2 % o 2 &S
MSCI AxJ Futures 2023 |2024|
Contract Multiplier US$100
Notional Value (1 Contract) US$49K (As at 31 January 2024)
Avg. Quote Size US$0.24Mn (5 Contracts) MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)
Avg. Bid-Ask Trading Spread 0.8 index points (January 2024) 140 - mgg: gé] '\Mﬂgg: lCr:]Zlir;a _____________ mgg: :—:;onesia
T T B IR MSCI Korea - MSCI Malaysia MSCI Pakistan
Liquidity Providers Fow and 11 banks 130 o e MSCI Philippines - MSCI Taiwan MSCI Thailand
120
Transaction Cost*
Stamp Duty N/A
100

Trading Fee US$0.5 / contract

90 -
SFC Levy US$0.07 / contract

80 T T )
Margin as of 30 Jan 2024 US$1,940 Nov-2023 Dec-2023 Jan-2024

MSCI AxJ is a well-established benchmark representing Asia

Futures contracts have relatively lower transaction costs . . .
regional (excluding Japan) equity market performance

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 31 January 2024



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2024)

HSCEI Correlation (2024)

10 largest and most representative
HKEX-listed mainland banks stocks

2,354.93 (As at 31 January 2024)
22.7

32.38 (January 2024)

0.96

0.959

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 30 Jan 2024

HK$50

HK$0.12Mn (As at 31 January 2024)
HK$0.59Mn (5 Contracts)

N/A

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$5,650

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 31 January 2024

5-Min Avg. Bid-Ask Spreads (31 January 2024)

HSMBI Futures
Minsheng Bank 1988.HK 0.67%
CEB Bank 6818.HK 0.61%
Bank of China 3988.HK

PSBC 1658.HK
ABC 1288.HK
CITIC Bank 998.HK
CM Bank 3968.HK
ICBC 1398.HK

CCB 939.HK
Bankcomm 3328.HK

Index & Constituents 3-Month Performance (Rebased to 100)

115 - —HSMBI ——CCB (939.HK)
ICBC (1398.HK) BOC (3988.HK)
110 - —ABC (1288.HK)
105 -
100 -
95 -
90 T . )
Nov-2023 Dec-2023 Jan-2024

HSMBI Futures can be used for hedging

14



CES120 Index Futures Performance

CES120 Index

80 A-Shares and 40 HK-listed Mainland

Index Description . ) )
China H-shares, P-chips, and red chips

Index Level 4,601.47 (As at 31 January 2024)
Index Volatility (30-Day Historical) | 21.6

Index Avg. Day High-Low Range 68.60 (January 2024)

CSI300 Correlation (2024) 0.909

FTSE A50 Correlation (2024) 0.856

5-Min Avg. Bid-Ask Spreads (31 January 2024)

CES120 Futures | NA

i 0,
R 0 Ik e X iShares A50 ETF (2823.HK) F 0.11%

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.23Mn (As at 31 January 2024)
Average Quote Size HK$1.15Mn (5 Contracts)
Average Bid-Ask Trading Spread| N/A

Liquidity Providers N/A

Transaction Cost* 100 - \/’\\/\_\
90 -

Stamp Duty N/A

Trading Fee HK$5 / contract
SFC Levy HK$0.54 / contract
Margin as of 30 Jan 2024 HK$11,830

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 January 2024

CES120 & Top Constituents’ 3-Month Performance

Rebased to 100

120 eeeeCES120 Index Tencent CCB
Ping An - China Mobile

110 -

80 -

70

Nov-2023 Dec-2023 Jan-2024

CES120 Futures can be used to hedge A-share positions

15



Flagship Futures - Contract Specifications

Hang Seng China Enterprises Index

Hang Seng Index Futures Hang Seng TECH Index Futures

Futures

Underlying Index
HKATS Code
Contract Multiplier
Minimum
Fluctuation

Contract Months

Pre-Market
Opening Period

Trading Hours

Last Trading Day

Final Settlement
Price

Exchange Fee

Data Source: HKEX

X

Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
HSI HHI HTI

HK$50 per index point

One index point

Short-dated Futures: Spot, next three

Short-dated Futures: Spot, next three calendar month & next three calendar quarter calendar month & next three calendar
months; quarter months;
Long-dated Futures: The three months of Jun and Dec plus the next three months of Dec Long-dated Futures: The three months of
Jun and Dec

8:45 am - 9:15 am & 12:30 pm - 1:00 pm

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am
(Closed at 4:00 pm on the Last Trading Day)

The second last trading day of the contract month
Average quotations of the underlying index taken at five minute intervals during the Last Trading Day

HK$10.00 HK$3.5 HK$5.00

16



Flagship Options - Contract Specifications

: Hang Seng China Enterprises .
Hang Seng Index Options Index Options Hang Seng TECH Index Options

Underlying Index Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
Monthly contracts: HSI Monthly contracts: HHI

HKATS Code Weekly contracts: “HSI” + Strike + Month + Weekly contracts: “HHI” + Strike + HTI
Year + “W” + Expiry Day Month + Year + “W” + Expiry Day

Contract Multiplier HK$50 per index point

Minimum Fluctuation One index point

Monthly contracts
Short-dated Options: Spot, next three calendar months & next three calendar
quarter months;
Long-dated Options: the next 3 months of Jun & Dec
and the following 3 Dec months

Monthly contracts
Short-dated Options: Spot, next three
calendar months & next three
calendar quarter months;
Long-dated Options: the next 3 months of

Contract Months /
Contract Weeks

Weekly contracts

Spot Week and the next week, except where the Expiry Day of the Weekly Contract Jun & bec
is the same as the Expiry Day of the Spot Month Contract
Exercise Style European Style
Option Premium Quoted in whole index points
Short-dated Options (monthly and weekly contracts): Long-dated Options (monthly contracts only):
Strike Price = 20,000 200 = 20,000 400
= 5,000 and < 20,000 100 = 5,000 and < 20,000 200
< 5,000 50 < 5,000 100
Trading Hours 9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am (Closed at 4:00 pm on the Expiry Day)

The second last trading day of the contract month (monthly contracts)

Expiry Day The last trading day of the contract week (weekly contracts)

Official Settlement
Price

Exchange Fee HK$10.00 HK$3.50 HK$5.00

Average of quotations of the Index taken at five minute intervals during the Expiry Day

Data Source: HKEX

X .



Flagship Futures Options - Contract Specifications

Hang Seng Index Futures Hang Seng China Enterprises Hang Seng TECH Index Futures
Iltem : . .
Options Index Futures Options Options

Hang Seng China Enterprises Index

Underlying Index Hang Seng Index Futures Hang Seng TECH Index Futures

Futures
HKATS Code PHS PHH PTE
Contract Multiplier HK$50 per index point
Min. Fluctuation One index point
Short-dated Options: Spot, next three
Short-dated Options: Spot, next three calendar months & next three calendar months & next three calendar
Contract Months calendar quarter months and quarter months and
Long-dated Options: the next 3 months of June & December and the Long-dated Options: the next 3 months
following 3 December months of June & December after Short-dated
Options

Exercise Style European Style
Quoted in whole index points

Index points | Strike interval Index points Strike interval

Short-dated Options: Long-dated Options:

Option Premium

Strike Price > 20,000 200 > 20,000 400
> 5,000 and < 20,000 100 > 5,000 and < 20,000 200
< 5,000 50 < 5,000 100

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am

Trading Hours

Expiry Day
Settlement on
Exercise

Official Settlement
Price

Exchange Fee

Data Source: HKEX

X

(Closed at 4:00 pm on the Expiry Day)
The third Friday of the contract month

Physical delivery on Exercise. All in-the-money options are automatically exercised upon expiry

Average of quotations of the Index Futures Contract of the same contract month,
taken at five second intervals from 3:55 p.m. — 4:00 p.m. on the Expiry Day of the Index Futures Options

HK$10.00 HK$3.5 HK$5.0
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Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan |[MSCI Japan
Information [NTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietham
NTR (USD)
Index Futures

HKSA Index
O#HMVN:
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X

22



Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X
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